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Winlmage is a shareware from an ASP member. You can copy it, distribute it, it is available on BBS or
CDROM. But if you use it, do not forget to register!



Winlmage is a disk image management utility. A disk image is a file which contains all the floppy data (file,
FATs, boot sector, directory...).

By making an image of a floppy disk and writing it on another, we get an exact copy (as with the Dos
DiskCopy command). We can read a floppy and write the image on the hard disk. The day after, without
using a floppy, we can extract a file from the image. The week after, we can write the image on two new
floppies, for instance, without needing the original, and create two exact copies of it.

We can also create disk images with Winlmage. If we want to put 5 files (taking 1.3 Mb) on a 3"1/2 HD
unformatted floppy, we create an empty 1.44 Mb image, inject the 5 files into it from the hard disk (this is
very fast) and, in one operation, we format the floppy and write the image on it.

Winlmage can format and use very large-capacity non-standard disks. (3"1/2 HD 1.72 Mb and 5"1/4 HD
1.44 Mb). To use them, you must load, before Windows, the TSR FdRead, a shareware from Christoph H.
Hochstatter which you can get with the FdFormat utility. | think that having a look at it is a must. You don't
need this TSR if you use only standard formats with Winlmage.

You can load an image by reading a floppy, or reading an image file, or creating an empty image.

You can extract the files of an image onto any device. (hard disk, network unit or... floppy).

You can also add files to the image.
The image can be copied onto a floppy (which must have the same format) or saved in a file.

An image file contains all the floppy sectors. If it's not full, you can truncate it.

Winlmage can read the images of a lot of disk copy utilities: Wimage (in FdFormat utility) from C.H.
Hochstatter, CopyVit from Sébastien Chatard, DrDos 6 and OS/2 2.x diskimage utilities, DCF (Disk Copy
Fast) from Chang Ping Lee, DF (Disk Image File Utility) from Mark Vitt, Super-DiskCopy from Super
Software, SabDu from S.A. Berman, Disk-RW from K. Hartnegg, DiskDupe from Micro System Design,
internal disk Microsoft and Lotus image utilities and the MFMT sample Windows NT application that
comes with Windows NT SDK.



Winlmage shows in its main window the files and directories present in the image. You can go into a
directory by double-clicking on it. To return to the parent directory, double-click on the first entry ("..").

Winlmage runs with the image in memory. When there is no image, some icons and menu entries are
grayed.

You can create a directory, delete or add files in the image with the icons or the Image menu. You can use
drag-and-drop from the Windows File manager to WinImage to inject data into an image, or from
Winlmage to another application to extract from it.

You can extract files in three ways: By extracting in the Image menu (or its icon), launching a file by
double-clicking on it, and dragging it to another application.

Winlmage allows you to drag the image file from Winlmage to another application: You put the mouse
pointer in the status bar or in the toolbar background. You press the left mouse button and keep it
pressed, put the mouse pointer onto another application (drag and drop client), and release the mouse
button. This original function allows you to add the image in a .ZIP or .ARJ file with Nico Mak's WinZip
utility, or attach the image to an e-mail created with Microsoft™ MS-Mail, or Lotus™ Notes or ccMail.
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New

Creates a new, empty image. You must select a format (by example 1.44 Mb).

Open

Opens an image file.

Close image

Closes the current image.

Save
Saves the current image.

Save as

Saves the current image with a new name.

Batch Assistant

Open Batch assistant dialog box.

Exit

To quit Winlmage.



Create directory

Creates a directory in the current image.

Select

Selects files in the current image.

Inject

Injects files into the current image.

Extract

Extracts files from the current image.

If no file is selected, Winlmage extracts all files from the image. Otherwise it extracts only selected files.
Depending on the Confirmation option, you will have to specify the extraction path. (a dialog box with
some Preference fields is shown).

Delete file

Deletes files from the current image, after asking for confirmation.

If there is no file selected, Winlmage deletes all the files from the image, otherwise it deletes only the
selected files.

Change Label

Changes the volume label of the current image.

Change size

Changes the size of the current image.

The new size must be greater than total size of the files in the image. (You can transform a 1.44Mo image
into a 360Ko image only if you have less than 360Ko of files).

Defrag current image

Defragments the current image files.






Use drive A: or B:
Use drive A: or B: to read and write floppies.

On a computer with two drives, this command lets you choose the unit you want to use for reading or
writing disks.

Read disk

Read a floppy and store its image in memory.

Compare disk

Compares current image with a floppy.
Write disk

Writes current image to a floppy.
Format and write disk

Formats a floppy and writes the current image onto it.



[]SoﬂbyName
Sort by Type
Sort by Size

Sort by Date

These options are used for displaying the file present in the image.

Font
Changes the current font (used for displaying the files present in the image).

Preference
Set Winlmage Options

You see this dialog box:
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Ignore unused track when reading : if this option is checked, when reading (or comparing) a floppy which
isn't full, Winlmage ignores the unused tracks.

Ignore unused track when writing : if this option is checked, when writing to floppy an image which isn't
full Winlmage ignores the unused tracks.

Verify writing : if this option is checked, Winlmage verifies when writing to a floppy. That takes more time,
but you are sure the new disk is readable.



Use only standard format : if this option is checked, Winlmage create only standard floppies (which don't
need FDREAD).

Select floppy for image : if this option is checked, Winlmage selects a floppy type for the image in
memory. (If you load a 360Ko image, Winlmage selects a 5"1/2 floppy format).

Truncate unused image part : if this option is checked, Winlmage reduces the size of the image when
writing an image file which isn't full.

Use incremented open/save wizard:. if this option is checked, Winlmage increments the filename by 1:

After opening (or saving) the "DISK01.IMA" file, Winlmage proposes "DISK02.IMA" for the next opening
(or saving).

Path : You specify here where from to get the files to form the image.
These three options are for extracting subdirectories (when directories are in selection when extracting, or
if there is no selection) :

Ignore subdirectories : Winlmage won't extract the subdirectory(~es) selected.

Extract all in the same directory: Winlmage extracts files in a subdirectory of the image in the Path
location.

Extract with pathname: Winlmage extracts files from a subdirectory of the image to a subdirectory of the
Path location.

Default viewer: defines viewer application launched when double-clicking on a file without association.

Confirmation
I Inject

[J Confirm injection by dropping from Winlmage

[ Confirm injection when replace a file in image

" Extract
[] Confirm extraction by menu or icon
(] Confirm extraction by diopping te Winlmage
(] Confirm extraction for Jaunch

Bl Confirm overwrite when extracting

[ Confitm file deletion

" Dptions for regiztered users

[ Dizplay screen when leading

[] Werily disk contents heloe write

[ o | Cancel | | Help |




Inject: The 2 first options allow you to enable/disable the use of a dialog box when injecting files. The last
is for ask confirmation when you replace

Extract: The three first options control the display of a confirmation dialog box when extracting files.

Confirm overwriting when extract: if this option is checked, if extracting risks overwriting a file, Winlmage
asks for confirmation.

When deletes files: this option controls the display of a confirmation dialog box when deleting files on
image.

Options for registered user: see Registering.

Verify disk content before write : if this option is checked, Winlmage asks for confirmation before writing
on a disk which contains data.

Sound and notification
Select sound and message

With this option, you can ask Winlmage to play sound (beep or, with a sound adapter, .WAV, .MID and,
under Windows NT, .AVI file).



With the batch assistant, you can chain operation on several image. By calling "Batch assistant” in file
menu, you see:
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When Winlmage execute batch, it repeat the sequence : make an image in memory (source) and use this
image for saving (destination). When the source has no image, the batch is complete.

You must select one source between:
- Set of floppies : Winlmage will read some floppies. You say how many floppies you want read.
- Set of images files : Winlmage will load some image. You can open a list file ((WIL), or add some
image.
- Directory injecting : Winlmage will inject directories on image. If the directory name contain number, it
can increment the directory name, and make an image for each directory. If a directory is bigger than
an image, Winlmage make several image

You must select one, or more, destination:
- Set of floppies : Winlmage will write some floppies. You say if you want format them.
- Set of images files : Winlmage will write some image. You specify the filename of the first, and
Winlmage increment filename. You can optionnaly make a list file (.WIL) with a comment.
- file extraction : Winlmage will extract file from image to directories you specifiy. It can increment the
directory name.

In this sample, Winlmage extract file image DISK1.IMA to DISK5.IMA on directories c:\temp\disk1 to c:\
temp\disk5.



January 1994: Version 2.00

- Batch assistant

- Show disk directory when reading

- Winlmage can be iconised when read or write a floppy

- New toolbar

- Image information

- Title bar

- Sound natification

- Support for .DLL resource (for other language than french or english)

September 1993: Version 1.11
Support of directory drag from Windows File Manager.

September 1993: Version 1.10

main differences:

- Windows NT version: built for the released version of NT, drag and drop server run correctly.

- Functions for deleting files in an image, changing format and defragmenting.

- Drag server of image file.

- Better usability: new menu, news option and confirmation dialog boxes, "Always on top" in system
menu, last 4 files in File menu, help on toolbar via button.

- Incremented filename.

- Better support of comparing and option saving.

May 1993 : Version 1.0

First version.

There are two versions of Winlmage: a 16 bit version for Windows 3.1 and a 32 bits version for Windows
NT (WINIMANT.EXE). It can't use large capacity floppies (there is no NT version of FDREAD), but
background reading or writing disk DOES ABSOLUTELY NOT slow working with another application.
There are both Intel 80x86 and Dec Alpha versions of Winlmage NT.

| hope you will send me a feedback about Winlmage. My CompuServe ID is 100144,2636 and my Internet
e-mail box is 100144.2636@compuserve.com.

If you find Winlmage useful, give it to your friend and upload it to your BBS.



Building a user-friendly software requires the help of a lot of people.

The Dos utilities FdFormat and Wimage from Christoph H. Hochstétter gave me some great ideas.
Without the source code, | couldn't format large format floppies.

By Building new icons and bitmaps, Francois Liger gave Winlmage a better look. By giving me some
pieces of code, he saved a lot of my time.

Correcting the french documentation, Monique Vollant allowed me to have a better syntax. Frangois Liger,
Joél Demay and Michael Segall did the same thing for the English documentation. And Kent Cedola build
the Dec Alpha Windows NT version.

Some ideas and tests have been coming from beta-testers. | thank David Chemla, Fabrice Letard and
Thierry Halin, and particularly Joé/ Demay, Michel Nedelec and Luc Coiffier.

Patrick Rafamantanantsoa, Bernard Maudry, Nico Mak, Serge Delbono and Michael Segall gave me
some additional ideas for Winlmage.



You can find the last version of Winlmage :

- on Compuserve, forum IBMHW (librarie disk/disk util), and WinShare (librarie disk/disk util et utilitaire
NT)

- On the BBS The Windows Manor, with these phone number (Paris, France) : (33 1) 42437852,

(33 1) 42432618 or (33 1) 42432458. Enter "J 25" command to go on the Winlmage area. You can
download WinImage or send me a message.

You can find these file : (xx is the version number, by sample WINIMA20.ZIP is a ZIP for version 2.0) :

- WINIMAXxx.ZIP : Help and both executable for Windows NT Intel and Windows 3.1

- WIMALTxx.ZIP : Help and executable for Windows 3.1

- WIMANTxx.ZIP : Help and executable for Windows NT Intel

- WIMAXPxx.ZIP : Help and executable for Windows NT Dec Alpha

- WIMATKxx.ZIP : Source file (.RC, .RTF) for translate Winlmage in your langage. You can build .HLP and
.DLL with ressource. This add a langage in the Preference dialog box.



Winlmage is shareware. You can copy, distribute and try it and it is available on BBS or CDROM. If you
use it, you must register. You will receive a license, the latest release and the next two releases, Dos
Extract and Inject tools.

If you register Winlmage, | send you a registering number. You can choose Registering in the Option
menu, and enter this code. After, you can in the Preference (Option menu) ask to hide the first screen.

The licence price is still 100 french francs or $20.00.

send a check to :

Gilles Vollant

13, rue Frangois Mansart
91540 Mennecy

France

Phone : (33) (1) 64 99 75 23

Site Licence : You can contact WindowShare B.P. 2075 / 57051 Metz cedex 2 France, Fax : (33) 87 32 37
75

You can use the CompuServe shareware registration service (GO SWREG). The WinImage registration
number is 1233.

Credit Card Ordering:

To order by MasterCard, Visa, American Express, or Discover, call the Public (software) Library at 1-800-
2424-PsL or 1-713-524-6394 or send your order by FAX to 1-713-524-6398 (U.S.A. phone number) or by
CompuServe Email to 71355,470. You can also mail credit card orders to PsL at P.O. Box 35705,
Houston, TX 77235-5705.

The Winlmage number on the PsL registration service is #10976 .

Use these numbers only for Credit Card orders. For site licenses or Winlmage information, contact me at
CompuServe 100144,2636.

This software is produced by a member of the Association of Shareware Professionals (ASP). ASP wants
to make sure that the shareware principle works for you. If you are unable to resolve a shareware-related
problem with an ASP member by contacting the member directly, ASP may be able to help. The ASP
Ombudsman can help you resolve a dispute or problem with an ASP member, but does not provide
technical support for members' products. Please write to the ASP Ombudsman at 545 Grover Road,
Muskegon, MI 49442-9427 USA, FAX 616-788-2765 or send a CompuServe message via CompuServe
Mail to ASP Ombudsman 70007,3536.






